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ABSTRACT

Industry standard transistor models used for computer aided circuit design are not

always accurately predicting transistor performance under all circuit conditions,

include RF and analog circuit behavior. Transistor model are expected not only

circuit performance but also reliability and accuracy. Improved accuracy may

need concern access to the internal currents and voltages of the transistor or add

extra internal features such as low-frequency noise sources. Circuits that have

very stringent accuracy requirements require modeling techniques with higher

accuracy. In contrast, Verilog-A enables full control of transistor model and can

be integrated with the circuit design software. This document report presents

how effective approach to investigate and implement our transistor model in two

different environments-AWR and Verilog-A. This is useful for circuit-level design

purposes to allow the designer manipulates transistor models have direct access

to model equation sets and program structure. A comparison of results between

simulation and measurements to transistor model has been illustrated in details.





Contents

Acknowledgments iii

Abstract vii

Table of Contents ix

List of Figures xiii

List of Tables xv

1 Introduction 1
1.1 Motivation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1

1.1.1 Challenges . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2
1.2 Thesis Overview . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2
1.3 Project Baseline Review . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3

1.3.1 Time Budget Review . . . . . . . . . . . . . . . . . . . . . . . . . 3
1.3.2 Financial Budget Review . . . . . . . . . . . . . . . . . . . . . . . . 4

2 Literature Review and Theory 5
2.1 FBH HBT Model . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5

2.1.1 Introduction . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5
2.1.2 Overview over HBT Model Features . . . . . . . . . . . . . . . . . . 6
2.1.3 Model topology . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6
2.1.4 large-signal Equivalent Circuit . . . . . . . . . . . . . . . . . . . . 6
2.1.5 Thermal Effect . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7
2.1.6 Importance of HBT modeling . . . . . . . . . . . . . . . . . . . . . 8
2.1.7 Challenge of achieve HBT modeling . . . . . . . . . . . . . . . . . . 8

2.2 VBIC Model . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 9
2.2.1 Compare Gummel-Poon model to VBIC model . . . . . . . . . . . 9
2.2.2 Review of VBIC model . . . . . . . . . . . . . . . . . . . . . . . . 10
2.2.3 VBIC model more suitable than Gummel-Poon model for HBT

modeling . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 10
2.2.4 Issues of VBIC model for HBT modeling . . . . . . . . . . . . . . . 11
2.2.5 Enhance VBIC model for HBT model . . . . . . . . . . . . . . . . . 12

ix



x CONTENTS

2.3 Noise Sources . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 12
2.3.1 Noise Phenomena . . . . . . . . . . . . . . . . . . . . . . . . . . . . 12
2.3.2 Thermal noise . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 12
2.3.3 Shot noise . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 13
2.3.4 Diffusion Noise . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 13
2.3.5 Flicker noise (1/f noise) . . . . . . . . . . . . . . . . . . . . . . . . 13
2.3.6 Generation-Recombination noise . . . . . . . . . . . . . . . . . . . . 14

2.4 Low-Frequency Noise Characteristics . . . . . . . . . . . . . . . . . . . . . 14
2.4.1 Low-Frequency Noise in Nonlinear Systems . . . . . . . . . . . . . . 14
2.4.2 HBT Noise Model . . . . . . . . . . . . . . . . . . . . . . . . . . . 14
2.4.3 How the low-frequency noise sources are implemented . . . . . . . 15

2.5 Verilog-A . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 16
2.5.1 Verilog-A Modules . . . . . . . . . . . . . . . . . . . . . . . . . . . 16
2.5.2 Advantages of Verilog-A . . . . . . . . . . . . . . . . . . . . . . . . 17

3 PDK Development Training 21
3.1 PDK Overview . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 21
3.2 Installation Guide for AWR Foundry SDK and the Model Wizards . . . . 22
3.3 Getting started with the model Wizard . . . . . . . . . . . . . . . . . . . . 23

3.3.1 Overview . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 23
3.3.2 MIM Cap imported from schematic . . . . . . . . . . . . . . . . . 23
3.3.3 Curtice FET with Parasitics . . . . . . . . . . . . . . . . . . . . . 25
3.3.4 Measure Internal Branch Current/Voltages . . . . . . . . . . . . . 25
3.3.5 Analysis of issues . . . . . . . . . . . . . . . . . . . . . . . . . . . . 26

4 Create models in NI AWRDE PDK 29
4.1 The Procedure of creatiing models . . . . . . . . . . . . . . . . . . . . . . . 29

4.1.1 Define the model . . . . . . . . . . . . . . . . . . . . . . . . . . . . 32

5 Results and Discussion 43
5.1 Resistor Model . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 43

5.1.1 A Linear Resistor in Verilog-A . . . . . . . . . . . . . . . . . . . . . 43
5.1.2 The simulation result of reisstor model in NI AWRDE . . . . . . . 44

5.2 Diode Model . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 45
5.2.1 A Nonlinear Diode in Verilog-A . . . . . . . . . . . . . . . . . . . . 45

5.3 Transistor Model . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 47
5.3.1 A Nonlinear Transistor in Verilog-A . . . . . . . . . . . . . . . . . 47

5.4 Chapter Summary . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 48

6 Conclusions and Future Work 51
6.1 Future Work . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 51

6.1.1 Add Noise to the Verilog-A Resistor . . . . . . . . . . . . . . . . . . 51
6.1.2 Add an Internal Node to the diode . . . . . . . . . . . . . . . . . . 51
6.1.3 Add limiting to the diode for get better convergence . . . . . . . . . 52



CONTENTS xi

6.1.4 The Verilog-A of transistor . . . . . . . . . . . . . . . . . . . . . . . 52

7 Abbreviations 53

A Verilog-A Code 55
A.1 Overview . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 55
A.2 Resistor in Verilog-A . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 55
A.3 Diode in Verilog-A . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 55
A.4 Transistor in Verilog-A . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 55

B Project Plan and Attendance Form 65
B.1 Overview . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 65
B.2 Consultation Meetings Attendance Form . . . . . . . . . . . . . . . . . . . 66
B.3 Project Plan . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 67
B.4 Project Consultation meetings . . . . . . . . . . . . . . . . . . . . . . . . . 67
B.5 LOGBOOK . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 67

Bibliography 67





List of Figures

2.1 Schematic cross section of a single finger HBT [8] . . . . . . . . . . . . . . 7
2.2 Extrinsic section of equivalent circuit. The model parameters are denoted

in oblique magenta letters [] . . . . . . . . . . . . . . . . . . . . . . . . . . 8
2.3 Intrinsic section of large-signal equivalent circuit. The model parameters

are denoted in oblique magenta letters [] . . . . . . . . . . . . . . . . . . . 9
2.4 Equivalent circuit for the VBIC bipolar transistor model [2] . . . . . . . . 11
2.5 Intrinsic large-signal of HBT and noise equivalent circuit [] . . . . . . . . . 15
2.6 Extrinsic large-signal of HBT and noise equivalent circuit [] . . . . . . . . . 16
2.7 Large-signal and noise HBT equivalent circuit [] . . . . . . . . . . . . . . . 17
2.8 Schematics illustrating the behaviour of low-frequency noise in large-signal

excitation (low-pass noise) [] . . . . . . . . . . . . . . . . . . . . . . . . . . 18
2.9 Schematics illustrating the behaviour of low-frequency noise in large-signal

excitation (cyclostationary noise) [] . . . . . . . . . . . . . . . . . . . . . . 19
2.10 Schematic indicating implementation of the partly correlated cyclostation-

ary noise source [] . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 20

3.1 PDK Development Tools [5] . . . . . . . . . . . . . . . . . . . . . . . . . . 21
3.2 The output window of Visual studio [5] . . . . . . . . . . . . . . . . . . . . 22
3.3 The “New AWR PDK Source Builder”dialog [5] . . . . . . . . . . . . . . . 23
3.4 Result of Code change [5] . . . . . . . . . . . . . . . . . . . . . . . . . . . 24
3.5 CURTICE Model [5] . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 25
3.6 NI AWRDE element browser [5] . . . . . . . . . . . . . . . . . . . . . . . . 26
3.7 Connect the VSWEEP step param to 1.0 to the Curtice 2P [5] . . . . . . . 27
3.8 Resistor Model [1] . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 27
3.9 Resistor in Verilog-A [1] . . . . . . . . . . . . . . . . . . . . . . . . . . . . 28

5.1 Circuit of Our Resistance . . . . . . . . . . . . . . . . . . . . . . . . . . . 44
5.2 I-V characteristic Curves of our resistor in both Harmonic Balance simula-

tor and APLAC DC simulator . . . . . . . . . . . . . . . . . . . . . . . . 45
5.3 Circuit of Our Diode . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 47
5.4 I-V Characteristic Curve of Our diode in both Harmonic Balance simulator

and APLAC DC simulator . . . . . . . . . . . . . . . . . . . . . . . . . . 48
5.5 Circuit of Our Transistor . . . . . . . . . . . . . . . . . . . . . . . . . . . 49

xiii





List of Tables

1.1 Time Budget Summary . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4

xv





Chapter 1

Introduction

Circuit simulation allows circuit designers to successfully optimize and validate their de-
sign. To simulate a circuit, circuit simulators convert the schematic into a system of linear
and/or nonlinear differential equations. In order to achieve a schematic to become a sys-
tem of equation, each component in the circuit must be represented by a smaller system
of linear and/or nonlinear differential equations. The smaller system for a component or
block is named as the compact model for component [7].

The availability of accurate, efficient compact models is important to the successful utiliza-
tion of any circuit simulation software. The need for rapid development and distribution
of advanced transistor device models becomes more acute than ever.

Traditionally, Transistor device models that are built-in circuit simulators have been de-
veloped using general purpose programming languages, such as C, C++, or Fortran.
Therefore, they are targeted specifically to the interface and internal data structures of
their host simulator. However, this kind of interfaces have typically been not-portable,
not standard and inefficient, which result a time consuming and error-prone endeavor in
new model creation.

The rapidly increasing availability and utilization of analog HDLs such as Verilog-A pro-
vides the promise of a valid outcome to transistor model development and deployment
problem. Over the past several years, Verilog-A has become a leading candidate for com-
pact model development. Recently, the compiled solution of Verilog-A become available,
which improve the performance of simulation.

1.1 Motivation

The compact transistor model is at core of circuit-level design of analog and radio fre-
quency integrated circuits(RFICs) enabling the designer to efficiently achieve design goals.
They are used for almost all modern electronic design work. Complete and accurate mod-
eling is based on correct design and analysis of electronic internal circuits especially the
analogs ones, which allows design to work earlier. Modern circuit are normally very com-
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2 Chapter 1. Introduction

plex. The performance of such circuit is difficult to predict without accurate transistor
models.

The motivation behind the works presented in this thesis is importance of compact tran-
sistor modeling in Verilog-A.

Industry standard transistor models used for computer aided circuit design. As system
become more complex and as devices become more sophisticated, smaller compact mod-
els are necessary for describe the behavior of systems and circuits. Therefore, industry
standard transistor models are not always suitable for all situations. Improved accuracy
may need access to the internal currents and voltages of the transistor or may be required
to add extra internal features such as low- frequency noise sources. Verilog-A language is
used for integrated with the circuit design software and allows transistor model designer to
focus on their area of expertise, which enable full control of the transistor model. The aim
of this thesis project is to investigate and implement Verilog-A models for our transistors
and compare with measurements.

1.1.1 Challenges

Challenges to designer:

• The compact model developers must be familiar with the Verilog-A computer pro-
gram.

• Required to familiar with how NI AWRDE operate with visual studio

• The developers require have good understanding about the characteristic of tran-
sistor models.

• PDK development traning the way it present, which is not clear.

• Required good undestanding in C, C++ code.

1.2 Thesis Overview

A brief description of the entire project will be summarized here in this section. TThe
project plan and deliverables can be found in Appendix B.3 of this document. This thesis
project is supervised by Dr Oya Sevimli, senior lecturer in the Department of Engineering,
Macquarie University and co-supervised by Prof. Tony Parker. Regular weekly meetings
with the academic supervisor are required which ensure the project is in the right track
with the set goals for every weeks. Consultation Meetings Attendance Form can be found
in Appendix B.2 of this thesis report.

There are 6 chapters in this thesis report. Chapter 1 gives introduce the whole thesis,
which includes the main purpose of this thesis project. Chapter 2 gives specific background
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information from the literature and discuss the related transistor models. Topics discussed
include The physical HBT, FBH HBT model, VBIC model, Noise sources and Low-
Frequency Noise Characteristics. It presents the characteristic of transistor and how
noise sources effect the behaviour of transistor.

Chapter 3 discuss how implement model wizard in AWR and using Microsoft visual studio
to create model. It also discuss what issues we encounter when implement the software and
how we solve it. Furthermore, the simulation results will be used to verify our transistor
model are accuracy or not.

Chapter 4 will include the procedure of how we create model in NI AWRDE PDK by
using NI AWRDE and visual studio

Chapter 5 will include summary about the thesis and demonstrate the contribution. It
include a linear resistor in Verilog-A and a nonlinear diode in Verilog-A. Compare the
simulation of our model to theoretical solutions. To investiage error of models and how
to figure out. Following by a discussion about our project to the future work.

Chapter 6 discusses the possible future work base on the current model in Verilog-A and
look at its benefits.

Project Objectives

• Revision of transistor models.

• Familiarize with simulation software such as AWR, visual studio and Verilog-A.

• Verification of transistor models through AWR nonlinear simulation.

• To investigate how noise sources effect the characteristic of transistor model.

1.3 Project Baseline Review

The project was planned to be executed from 1st of March through 24th of June, 2016.
Baseline plan was generated with the intention of using only the weekdays, including
mid-semester break, for project activities.

1.3.1 Time Budget Review

Table 1.1 summarizes the time budget comparison, according to which 42 days of work
has been completed within 35 days. The rest days shall be used for composing the project
report, therefore no amendments to the time schedule is required.
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Although the allotted time for each activity was followed closely, the order of accomplish-
ment varied. Overall, the progress of the report is followed with the project schedule done
at start of the semester. Full detail of actual and planned order of accomplishment and
duration of each project activity is depicted in Table 1.3.

Estimated Work 80 days
Realized Work 42 days

Percentage Completion 50%

Table 1.1: Time Budget Summary

1.3.2 Financial Budget Review

The project was initially allocated $300. The project didnt require to buy anything except
it required AWR and Visual studio software which I have downloaded from DreamSpark
and installed in my laptop. Therefore, there is no further purchasing is required, thus the
budget surplus may not need.



Chapter 2

Literature Review and Theory

2.1 FBH HBT Model

2.1.1 Introduction

Device models are usually used in circuit simulation for the design of integrated circuits.
The Heterojunction Bipolar Transistor(HBT) is based either on the GaAs/AIGaAs or
GaInP/GaAs compound semiconductor material. In recent years, heterobipolar transis-
tors can be achieved by using commercial GaAs MMIC technology. Due to their advan-
tages able to operate at high power densities they are the devices suit for power amplifiers,
such as in mobile phones. Although technology is mature and industry already has a large
amount of HBT-based MMICs, the model development in circuit design lacks behind. The
designer has a batch build-in models for GaAs-based FETs in standard circuit simulators,
however models for GaAs-based HBTs are scarce. The choice to use neither the simple
SPICE-type Gummel-Poon model nor full design with a linear S-parameter based model.
None of them are satisfy the requirement.

It leads to deal with extension of the GP model that are required for the description of
HBTs, and finally tend to the development of FBH model. The state-of-the-art GaAs-
based HBTs have characteristics as below:

• The semi-insulating substrate to avoid parasitic substrate effects that have to be
considered in silicon.

• In a sophisticated technology, surface or interface involved problems such as parasitic
currents are inappreciable, and even thermal runaway can be restrained by using
base feedback or proper emitter or by using thermal shunt technology.

Two effects are necessary to be considered in simulate HBTs. The first one is self-heating,
the second one is the current dependence of the transit frequency, effected by high current
injection into the collector.

5



6 Chapter 2. Literature Review and Theory

2.1.2 Overview over HBT Model Features

The FBH model consider:

• Differentiation of intrinsic and extrinsic base-collector diode

• Non-ideal base currents (Base-Collector and Base-Emitter)

• Thermal interaction and self-heating (by a thermal port)

• Collector transit time and current-dependence of base-collector capacitance

• Charge differentiation

• Break-down involved with base-emitter and base-collector

• Strengthened noise model

• Scaling with transistor size

• Unclear analytic parameter extraction from measurements

2.1.3 Model topology

Since substrate effects are inappreciable, it leaves a very simple equivalent-circuit topology
as shown Figure 2.1. Because of the structure of the HBTs, the total base-collector
junction separates into an active part below the emitter, and a parasitic part below the
base contacts. Due to current flows nearly vertically from emitter to sub-collector, the
parasitic section has an extra PN diode which is reverse biased in usual operation. The
section under the emitter is named as active HBT in order to differentiate it from the
parasitic BC-diode which conveys no current. But, both of them are portion of the
intrinsic HBT, because the parameters are bias dependent. Only the passive embedding
network is named as extrinsic HBT.

2.1.4 large-signal Equivalent Circuit

The extrinsic section of the large-signal equivalent circuit is shown in Figure 2.2. It
shows the passive feeding structures and contact resistances. Assume all parameters are
independent of bias and therefore are same to the small-signal parameters.

The intrinsic large-signal equivalent circuit is shown in Figure 2.3. The extra electrical
section, it contains a thermal sub circuit to determine the self-heating of device because
of dissipation of power. The current source uses to amplify the base currents in forward
and backward operation. Only the current flow through the resistances is amplified, as
determined in the figure. The current amplification factors are called BF.
The diode symbols depict bias dependent resistances with diode characteristics. The
forward operation case, the collector current is structured by the current source. The
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Figure 2.1: Schematic cross section of a single finger HBT [8]

current Icf/BF depicts the ideal base-emitter current which is amplified. The currents
I ′b,I

′′
b, and I ′bc depicts the nonideal (parasitic) base currents. The circuit contains bias

independent resistors Rbxx, Rbbxx, and Rcxx to generate the possible saturation of these
current elements. The base-collector current is divided into two components because of
the mesa structure of the HBT: The active HBT include the current I ′cr and the parasitic
current I ′′cr. I ′cr is effected by the voltage across the parasitic section of diode. Both
diodes are split by the resistance of the intrinsic base layer Rb2 that is assumed as a
constant value.

Two current sources Iav,c and Iav,e are used to break down base-collector and base-emitter.

Two charges are used for both junctions, a depletion (Qxj) capacitance and a diffusion
(QxD).

The total dissipated power Pdiss is supplied to a thermal subcircuit.

The voltage 4T j is equal to the temperature rise at the emitter junction because of
self-heating of the device.

2.1.5 Thermal Effect

Because of the large thermal resistivity of GaAs, thermal effect containing self-heating
are very important in GaAs-based HBTs and must be taken into account when determine
the large signal performance of the device. The equivalent circuit denoted in Figure 2.3,
the temperature increase at the emitter junction can be figure out. The emitter junction
temperature replace the device temperature is used since the temperature distribution
is no uniform through the device and the most meaningful effect in temperature rise on
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Figure 2.2: Extrinsic section of equivalent circuit. The model parameters are denoted
in oblique magenta letters []

device performance happen at the emitter junction. The Rth in the circuit stands for
thermal resistance corresponding to the junction temperature increase. Normally, Rth is
a constant value in order to simplify the circuit. (A New Large Signal HBT Model)

2.1.6 Importance of HBT modeling

Heterojunction Bipolar Transistor(HBTs) offer substantially great power gain cut-off fre-
quencies. In GaAs/AlGaAs or GaAs/GaInP devices, the wide bandgap emitter allows
large base doping without significant charge enter into emitter, giving low base resistance
even the device with small base widths.

Physically significant HBT models provide the ability no only to predict and to design
a practical circuit with good accuracy, but also to estimate the device parameters how
they affecting the circuit performance. This could achieve the optimization of device
design with respect to a particular application and the evaluation of the manufacturing
process [9].

2.1.7 Challenge of achieve HBT modeling

The problem of how to construct a precise model for GaAs/AlGaAs or GaAs/GaInP HBT
can becomes a prominent issue.

An accurate device model that allows the reliable for a wide range of operating biases and
signal frequencies is need for the design of high performance microwave circuits. Recently,
existing bipolar transistor models used in most commercial circuit simulators, which are
based on the Gummel-Poon model. It does not consider several effects which are im-
portant for predict the performance of HBT. Especially, the self-heating effect has been
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Figure 2.3: Intrinsic section of large-signal equivalent circuit. The model parameters
are denoted in oblique magenta letters []

recognized as critical factor in determine the operation of HBT at high power dissipations,
because of the low thermal conductivity of GaAs. To design circuits in which thermal
effects are critical, dependence of junction depletion capacitance and transit time on col-
lector current, and variation of effective electron barrier in an emitter heterojunction [12].
The thermal and electrical behavior of the circuit must be modeled and solved consis-
tently, which can be complicated. No only this, but also a circuit model for GaAs/AlGaAs
HBT is required in nearly all software and simulators to effectively regenerate the physical
properties of the device in any new design. Modeling of GaAs/AlGaAs HBT can be very
tedious task due to its complexity of device geometry, long process of linear and non-linear
model parameter extraction and non-linear properties of the device.

2.2 VBIC Model

2.2.1 Compare Gummel-Poon model to VBIC model

Since the early 1970s, the SPICE Gummel-Poon model has become the workhorse for
silicon bipolar junction transistor modeling. The construction of the Gummel-Poon(GP)
model has consideration in the pivotal physical parameters and mechanisms that allow
to control BJT behavior in intuitive and consistent manner. However, the approximation
that underlie the Gummel-Poon model ignores the effects, which are critical for sufficiently
accurate modeling of BJTs. [4] Such as:

• Parasitic transistor, self-heating, avalanche multiplication is not modeled.

• Collector resistance modulation is not take into account

• Simplified Early effect model is not accurate
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The VBIC model for bipolar transistors is an extension of the Gummel-Poon model for
Si bipolar transistors. The VBIC models has been improved base on the Gummel-Pool
model in the follow aspects:

• Improved temperature

• Improved Early effect on transit time

• Parasitic substrate

• Parasitic transistors

• Parasitic fixed (oxide) capacitance

• Quasi-saturation modeling

• Avalanche multiplication

• Decoupled base current from collect current

• Electro thermal (self-heating effect) modeling [10]

2.2.2 Review of VBIC model

Before talk about the VBIC model, we give a brief review about the SGP model. It
is a three-terminal model such as emitter, base, and collector terminals and contains
three current sources ICC ,Ibc and Ibe, two capacitances related with the charges Qbc and
Qbe stored between the base and collector terminals and between the base and emitter
terminals, respectively, and four series resistances.

Basic on Figure 2.4 presents the equivalent circuit if the new VBIC model. Different with
the conventional SGP model, which is three terminals, the VBIC has four terminal model
including the base, emitter, collector, and substrate expressed by the letters b, e, c and
s, respectively, and the current entering into these terminals are Ib,Ie,Ic andIs. The other
node of VBIC model are extrinsic base bx ,intrinsic base bi, parasitic base bp, intrinsic
emitter ei, intrinsic collector ci, and extrinsic collector cx [2].

2.2.3 VBIC model more suitable than Gummel-Poon model for
HBT modeling

The VBIC bipolar junction transistor model is a candidate for GaAs HBT modeling for
a couple of reasons:

• Self-heating and excess-phase effects is included in VBIC model

• It offers a base current model that is a more accurate approximation to the actual
device than the one which is used in the conventional Gummel-Poon(G-P) model
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Figure 2.4: Equivalent circuit for the VBIC bipolar transistor model [2]

• The base current and the collector current are not relevant through a constant
current gain as in the G-P situation

• Quasi-saturation behavior in VBIC model

• It is available in commercial circuit simulators

2.2.4 Issues of VBIC model for HBT modeling

Currently, Existing industry models such as Gummel-Poon(G-P) model and VBIC model
are not sufficient to characterize the GaAs/AlGaAs HBT device. VBIC is not perfectly
suitable for GaAs/AlGaAs HBT devices because:

• The ideality factors of base-collector and base-emitter current components in HBT
is variation with temperature, which is not modeled by VBIC model [3].

• The physical effects involve with high current effects in VBIC model dose not match
the GaAs/AlGaAs HBT device.
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• The thermal resistance of HBTs is usually to be temperature dependent, which is
not modeled by VBIC model [3].

• Relatively high operation current densities make HBTs very sensitive to the base
push-out (Kirk) effects, which are required more accurate modeling of transistor
time and the current-dependent collector capacitance [3].

• The transistor time frequency is not right when VBIC model is adopted to the
GaAs/AlGaAs HBT device.

• The relatively lightly doped collector of GaAs/AlGaAs HBTs make the mobile
charge modulation, which is required to be take into account in collector capaci-
tance [11]

• Collector punch-through has a no negligible effect on the capacitance [11]

2.2.5 Enhance VBIC model for HBT model

In order to perfectly match the the GaAs/AlGaAs HBT device, a modified VBIC models
required in improve with transport current, transits-time and collector capacitance. And
also the extraction and optimization of VBIC model parameters are required to be devel-
oped. Therefore, the advance VBIC model keeps all of the features of the existing VBIC
model while consist of new features with a couple of additional model parameters that
are capable of solve the previously effects.

2.3 Noise Sources

2.3.1 Noise Phenomena

There is various style of noise phenomena in electronic devices which result in a fluctuation
of the signals. The most significant styles are thermal noise, shot noise, diffusion noise,
generation-recombination noise, and flicker noise (1/f). The amount of influence of one
noise phenomena to the whole noise not only due to the device and its characteristic of
operation but also on the operation conditions which is included temperature, bias point,
and frequency. A detail of description of noise phenomena is presented in the following
parts.

2.3.2 Thermal noise

Thermal noise is produced in any physical resistance that indicates dissipation when
current is flowed through it. Thermal noise is a type of electronic noise effected by the
random thermal motion of the charge carriers producing microscope current fluentuations.
It was formulated first by Nyquist and Johnson in 1926, and is named as Johnson-Nyquist
noise. Thermal noise is directly affected by the absolute temperature T and is not related
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to applied voltage or current. In a resistor, thermal noise is called as white Gaussian
noise. A series voltage generator or shunt current used to model thermal noise, which is
defined as

v2
= 4kTR4 f

or

i2
= 4kT

1

R
4 f

Where R refers to circuit resistance, k refers to Boltmanns constant. 4f refers to band-
width in hertz and T stands for absolute temperature, which is at the room temperature
approximate 300◦K.

2.3.3 Shot noise

Different to thermal noise, shot noise is always depending on a direct current flow. It
involves in diode and transistors. Shot noise is determined by fluctuation in current that
is effected by carriers flowing through the potential barrier at the junction. Such as the
emitter-base or base-collector junction in transistor. The noise current generated by shot
noise can be defined as:

i2
= 2qID 4 f

Where q refers to the electronic charge which is equal to 1.6 ∗ 10−19 C, ID is the bias
current.

The shot noise is also called as white noise and it is proportional to the bias current.

2.3.4 Diffusion Noise

Diffusion noise happens in semiconductors with electron density gradient dn/dx where the
thermally activated electrons move from places with a high electron concertation to places
with a low concentration. The noise is effected by collisions of the moving carriers with
the lattice.

2.3.5 Flicker noise (1/f noise)

Flicker noise refers to a physical property in all active devices. It has an enormous influence
on circuit. Flicker noise is a low- frequency noise. It is also called as 1/f noise because
noise is produced with a slope inversely proportional to the frequency. There is not lower
frequency limit for the 1/f noise and the overall noise power can be infinite. Flicker noise
can be expressed in term of voltage noise spectrum SV or resistance noise spectrum SR

or current noise spectrum SI or conductance noise spectrum SG, and these spectra are
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normally standardized. Such as SV /V
2, SR/R

2, SG/G
2. In 1969, Hooge suggested that

the fluctuations in conductivity will cause 1/f noise. Flicker noise is normally defined as

i2
= Kf

IAF
DC

f fFE 4 f

Where Kf refers to level fitting, Af refers to the current dependency factor, and fFE

refers to the frequency dependent power factor.

2.3.6 Generation-Recombination noise

Generation-Recombination (G-R) noise is one style of electrical noise produced by fluctu-
ations in the amount of free carriers in semiconductor materials.

2.4 Low-Frequency Noise Characteristics

2.4.1 Low-Frequency Noise in Nonlinear Systems

There are two dominant noises at low frequency which are flicker noise and G-R noise.
Because of up conversion effects, low-frequency noise can play a crucial role in HBT model.
Traditionally, bipolar large-signal models only consider low frequency noise produced at
the base-emitter junction. The low-frequency noise behaviour of HBTs is important. To
find out where the noise sources are located and which of these sources dominate, it is
require to consider the dependences of the noise behaviour on transistor geometry, bias
point, temperature and frequency.

2.4.2 HBT Noise Model

The large-signal model employed is the FBH model developed for GaAs-based HBTs.
The equivalent circuit containing noise sources is indicated in Figure 2.5. All resistances
Rb, Rb2, Re, Rc shows thermal noise at the actual junction temperature Tj. Shot noise is
contained by two correlated noise sources. The current Ibe is drive the base-emitter shot
noise. The current If = βf ∗ Ibe is drive the collector-emitter shot noise.

In Figure 2.6, all resistances generate thermal noise, < |ib|2 > and < |ic|2 > present
shot noise. The sources at the base-emitter junction < |in ∗ fb|2 >, and at the emitter
resistance < |vn ∗ fe|2 > generate low-frequency noise. Additionally, the model considers
the second noise source which represent the Hooge noise contribution of the bulk emitter.

In the equivalent circuit of combination for both intrinsic and extrinsic of HBT, Figure
2.7, the location of this noise is defined as “base-emitter noise source”. In case of HBT
models, the noise is effected by current and frequency.
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Figure 2.5: Intrinsic large-signal of HBT and noise equivalent circuit []

In Figure 2.7, the base and emitter resistances Rb, Rb2, and Re are very low value
in modern HBTs in order to achieve very low collector noise currents. Therefore, the
base-emitter noise source is almost short circuited. The Oppositely, the noise for high-
impedance source is not affected, because the emitter branch is almost connected to an
open circuit which result the voltage noise source does not drive any current. The emitter
noise source is mainly determined by the collector noise current.

2.4.3 How the low-frequency noise sources are implemented

• Low-pass noise sources

The modelling interface of the circuit simulator provide low-frequency noise sources.
In Figure 2.8, the noise level is effected by a function of current f (I), and the output of
noise signal is low pass filtered.

• Cyclostationary noise sources

In Figure 2.9, a function of current f (I) is multiplied with a constant low-frequency
noise. A sub circuit is implemented by using the instantaneous current when calculating
the noise source through the simulator in order to get a cyclostationary source.

• Partly correlated cyclostationary noise sources

In Figure 2.10, the implementation is quite similar to the cyclostationary source, however
it need to separated noise sources, and high-pass and low-pass filtering of the current.
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Figure 2.6: Extrinsic large-signal of HBT and noise equivalent circuit []

2.5 Verilog-A

Verilog-A is a procedural language, with constructs similar to C and other languages. It
offers simple constructs to describe the behavior of model for the simulator program. The
program language allows circuit designers to create modules (behavioral blocks in a cir-
cuit) and define the characteristic of modules by specifying the mathematical relationships
between the currents and voltages terminals of the modules. Verilog-A was recently en-
hanced to offer greater support for compact modeling. The NI AWR Design Environment
provides a complete software solution, which promotes the compact model development.
Due to its ease of use, efficient system design and powerful circuit simulation. Verilog-A
can be used directly in circuit simulators - as well as parameter extraction of NI AWR
Design Environment, which enable to handing measured data.

2.5.1 Verilog-A Modules

A module is a unit of Verilog-A code that is used to describe a component. In Verilog-A,
the built-in primitives depict common circuit components, such as capacitors, inductors,
resistors and semiconductor devices. A module that simplify refers to other modules is
known as a structural model. In Verilog-A, components are constructed by using branches
and nodes. A node is defined as a point where endpoints of braches may connect, and a
branch is defined as a single path between two terminal nodes. Nodes and braches are
constrained by Kirchhoffs laws, which is represented as below:

• The flow enter into a node must always sum to zero.

• The potential is the same everywhere on a node
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Figure 2.7: Large-signal and noise HBT equivalent circuit []

• The potential on a branch is equal to the difference potential between two nodes,
which are connected.

• The flow enter into one terminal of a branch is always equal to the flow out of other
terminal [1].

2.5.2 Advantages of Verilog-A

The main reason for preferring Verilog-A for compact modeling rather than other general-
purpose programming languages is free the model developer from the burden of dealing
with the simulator interface.

Generally, the modeling user interface of simulator in Brand A is quite difference to other
modeling user interface of simulator in using and definition of variables. As a result of
this, is very hard to implement the same model in different simulators without extra
programing errors and compiling warnings, at the first trial. With Verilog-A, new models
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Figure 2.8: Schematics illustrating the behaviour of low-frequency noise in large-signal
excitation (low-pass noise) []

can be added nearly as quickly as the equations can be defined. Furthermore, it can
maintain control of the intellectual performance of the model within various simulators.

Verilog-A also offers a powerful system for defining model parameters. The declaration
statement contains the default value and can specify the range of effective values. The
default value may also define as a function of other parameters, which is very useful to
determine the relationship between input signal and output signal. As a result, Verilog-A
is an extremely efficient program language for writing compact models [4].
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Figure 2.9: Schematics illustrating the behaviour of low-frequency noise in large-signal
excitation (cyclostationary noise) []
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Figure 2.10: Schematic indicating implementation of the partly correlated cyclostation-
ary noise source []



Chapter 3

PDK Development Training

3.1 PDK Overview

A process Design Kit is a complete set of files used within the semiconductor industry to
model a fabrication process as the design tools, which are critical for design an integrated
circuit. The PDK is identify by the foundry defining a certain technology variation for
their process. The PDK can be used for design, simulate, draw and verify design, which
improving design more efficiency, reducing the design cycle times and ensuring quality [6].
Basic on Figure 3.1 explains the detailed information of PDK and how it operation. The
elements of a PDK are Device Symbols Device Symbols & View, Model, Parameterized
Cell(PCell), Technology File, PV Rule and Documentation. These elements are required
for each design state.

Figure 3.1: PDK Development Tools [5]

21
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3.2 Installation Guide for AWR Foundry SDK and

the Model Wizards

In order to approach the thesis project, we start with PDK development training. To
get familiar with how implement model wizard in AWR and using Microsoft visual studio
to test model. The NI AWR version 12 and Microsoft visual studio 2013 is required to
download. The software development Kit(SDK) is download from the AWRCorp. web
site. The AWR Dev Folder includes:

• AWR Folder includes the sample solution TEST SDK, which is used for verifying
SDK installation and working samples

• Documentation Folder-includes training presentations and reference documents

• Generic-includes a sample PDK used for training

• SDKv12-includes the Model and Cell Wizards, and also contain the Lib files required
to build PDK Solutions

• Supporting Files-include example projects [5]

According to instruction, we registering Model and Cell Wizards, ensure wizard installed
correctly. Open the file AWR Dev\AWR\AWR.sln in Microsoft Visual Studio. We got
the below message, which confirms the visual studio and AWR SDK setup correctly.

Figure 3.2: The output window of Visual studio [5]

The Script is used to generate a new PDK process with a different name. We use compa-
nyName, CoName, and ProName as general names, which is showed as below:

The new PDK directory structure has all Visual Studio project. Open Microsoft visual
studio allows to build the projects and verify the project build.
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Figure 3.3: The “New AWR PDK Source Builder”dialog [5]

3.3 Getting started with the model Wizard

3.3.1 Overview

• The NI AWR design environment has various circuit simulators. Two simulator is
named as AWR and Aplac. Both of them has linear and non-linear simulator. Both
AWR and Aplac simulators can be used for any linear model. Non-linear models
will require a dll for AWR and a different dll for Aplac simulator.

• Creating an aggregate model by importing it from the AWR schematic into the
model wizard. Schematic can include both linear and nonlinear elements.

• The Model Wizard will produce C++ code, which is used for defines a new element.

• The following is an traning by using the wizard to get code for a MIM capacitor [5].

3.3.2 MIM Cap imported from schematic

Start NI AWRDE and open the ‘AWR CAP HF.emp’ project file. No only we are allowed
to fill the properties by modify Model parameters, and also allows to enter parameter
formula, which define the behavior of capacitance. We launch Visual studio after the
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model wizard create the .cpp file. Open the solution file by using MS Visual Studio. MS
visual studio allows source code of AWR CAP HF to be add into the project. Therefore,
we can test the model.

Create the schematic of cap and add S21 Smith Chart Graph. Edit and continue option
in Visual Studio enables the user to debug a model source code by inspecting at the code
and the simulation results in NI AWRDE simultaneously. By modify the equation for C
to read C=CA*W*L. S21 Smith chart Graph is changed shows as below:

Figure 3.4: Result of Code change [5]

Edit and continue is effective for debugging models and making modify easily.
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3.3.3 Curtice FET with Parasitics

Overview

• This time will again be an aggregate model from a schematic

• The model is a Curtice FET with some extra parasitic.

• We add an Enumerate parameter to set a gate-gate pitch value

• The parasitic as a read-only parameter [5]

The execute procedure is pretty much similar to MIN Cap, instead we use Curtice FET
and add more extra parasitic. There are some issues when add the model, which is named
as Curtice 2P. It shows as below:

Figure 3.5: CURTICE Model [5]

Figure 3.6 , because we tick hide model name. Therefore, NI AWR could not find element,
which is named as ‘CURTICE 2P’.

Basic on Figure 3.7 , to determine the IV curve of CURTICE 2P.

3.3.4 Measure Internal Branch Current/Voltages

AWR nonlinear models allow to access the internal nodes of a nonlinear model by using
branch labels. Adding branch labels directly to the Verilog-A allows the model wizard
to deal with all of the branch labels automatically. Understanding Verilog-A is very
important for achieve accurate models.
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Figure 3.6: NI AWRDE element browser [5]

According to Figure 3.9 , the first line defines the name of the component, in this case
is resistor. Two pins, which are nodes are t1 and t2. The second line declares the nodes
as being electrical, meaning that the potential of each node is a voltage and the flow into
the node is a current. Verilog-A defines the flow into the pin to be positive if the motion
is into the component. The third line declares a parameter, r for the component. The
values of parameter can be specified when we instantiate the resistor. The value given in
the parameter declaration is set as the default value of the parameter. The value of r is
keep constant within the module. The fourth line declares a branch is named as res and
it present t1 and t2 pins are connected [1].

V(res) <+ r*I(res) using of the contribution operator (<+) achieve this a contribution
statement. It represents an equation that the voltage on branch res must equal to the
current through branch multiplied by r [1].

3.3.5 Analysis of issues

There are some issues occur during PDK development training. These may involve with
AWR Version issue in simulation. The one we use is AWR V12, however the PDK
development training is implement in AWR V11. Somehow, the simulation is not running
in AWR V12, which may because some properties of AWR V12 is different with AWR
V11. Configurations for Win32 platform and x64 platform used for test the model in
Visual Studio, which only operate successful in x64 platform, but not Win32 platform. It
may because our computer is running at 64-bits, that may not compatibility with Win32
platform.
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Figure 3.7: Connect the VSWEEP step param to 1.0 to the Curtice 2P [5]

Figure 3.8: Resistor Model [1]
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Figure 3.9: Resistor in Verilog-A [1]



Chapter 4

Create models in NI AWRDE PDK

4.1 The Procedure of creatiing models

• Start NI AWRDE and choose Scripts→ Configuration→ Import Send Remove Script

Select Import and press OK.

Select .bas and press OK.

29
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• Browse to AWR Dev\SDKv12\ scripts\ MakeNewPDKProcess.bas to import it as
a global script. The script will be appear in the Scripts menu when we restart
Microwave office.

• Choose Scripts→PDK→Make New PDK Process

• The “New AWR PDK Source Builder” dialog is appeared. Fill it out.
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• Press OK. Select the AWR SDK Directory. In our case, we select AWR Dev\
SDKv12 folder.

Therefore a new PDK folder will be created in the AWR Dev folder.

• Add the CoName ProcName PDK to the project file by choosing File→ New With
Library Select “Browse” and navigate to the file CoName ProcName.ini then click
open.
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4.1.1 Define the model

• Launch the Model Wizard from the Wizards branch of Project Browser.

• Choose ‘electrical’ as the model wizard type and import Verilog-A of My bjt.

• Press ‘Edit Model Definition’. In the Model Definition tab, enter the model de-
scription, which is called as My bjt. Model category is defined as user\nonlinear.
Choose BJT@system.syf as our Schematic Symbol. Delete the contents of the Help
file and Help context ID.
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• In the parameters tab shows there are 62 model parameters in our bjt model. No
Modifications Needed.

• In the Implementation tab, untick ‘Hide model name’ to allow the model from
appearing in the NI AWRDE element browser. Aggregate model is chosen auto-
matically.

• No Modification Needed in Netlist/Admittances tab.

• Finally go to the Source tab. Set the output filename to “My bjt.cpp.” Click OK
to finished editing the model.

• Save the Model Definition in the folder: AWR Dev\CoName\ProcName\Models Src
with the name My bjt.mwz.

• Click on ‘Generate Source Code.’ The model wizard will generate the .cpp file and
launch Visual studio.

There is 1 Controlled-Sources so it is necessary to generate APLAC source code. In order
to operate APLAC DC Simulator in later section.

• From the file menu, open the solution file AWR Dev\CoName\CoName.sln. Right
clicks on CoName ProcName models and select Set as Startup project. Click on
the dropdown for the CoName ProcName Models project.
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• Right mouse clicks on ‘Source File’, select Add→ Existing Item . . . and add My bjt.cpp.
Right mouse clicks on CoName ProcName Models and select Rebuild to compile the
My bjt.cpp file and create a model dll.

• The output window should show a message that the rebuild is successful.

• Press ‘Generate APLAC Source Code’ and Select ‘InterfaceTable.c’ to create a .c
file. Right click on CoName ProcName models and select Set as Startup project.
Click on the dropdown for the CoName ProcName Models APLAC project. Right
mouse clicks on ‘Source File’, select Add→Existing Item . . . Add My bjt.c and In-
terfaceTable.c that can be used to create an APLAC model dll. Double click on the
file InterfaceTable.c in the Source Files list to bring the file into the Visual Studio
Editor. Copy the model name from InterfaceTable.c and paste the name into the file
AWR netlister APLAC.cpp in location of AWR ADD OBJ TO TRANSFORMER
(basic APLAC,“First Model Name Here”, MWO TO APLAC) for first model name.
In order to add more models by remove the // at the beginning of the line, there-
fore the line is no longer a comment. The CoName ProcName netlister APLAC
file is used to give the proper model name in NI AWRDE when creating the
APLAC netlist. To add additional model names to the APLAC netlister, Re-
moving the “//” from the beginning of the line. Paste the model name into the
‘AWR ADD EXISTING OBJ’ macro when require to create additional model name.
Right mouse clicks on CoName ProcName Model and choose ‘Rebuild’ to update
the models dll. Rebuilding to allow automatically save the modification in the file
CoName ProcName netlister aplac.cpp.
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• Restart NI AWRDE and open new library with → CoName ProName. In elements
tab, we will find our model in user\nonlinear.
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Chapter 5

Results and Discussion

In pervious chapters, we have discussed the theroy about FBH HBT models and how to
create models through NI AWRDE and visual studio. In this chapter, we will provide
our simulation result from our model, which generated by using NI AWRDE and visual
studio. We are going to discuss each simulation result of our models and Compare the
simulation result to theorical solution . The error of simulation result will be investiaged.
In the following section, we are going to explore the characteristic of our model in NI
AWRDE and explain the Verilog-A code given in Appendix in details.

5.1 Resistor Model

5.1.1 A Linear Resistor in Verilog-A

module My Resistance(p,n);
inout p,n;
electrical p,n;
parameter real resistance=50;
analog
V(p,n) <+ resistance*I(p,n);
endmodule

Between line 1 and line 7 declares the module block, within is how the model behaviour
is being defined. The first line defines the name of our model, which is named as My
resistance. There are two ports, which called “p” and “n”. “p” is input port and “n”
is output port. The nature of those ports declared in the electrical discipline. In our
case refer to the flow enter the pin is a current and the potential of each pin is voltage.
The fourth line declares a parameter which is called as resistance and set is as a default
value of 50.0. In our case, the parameter is defined as real type. The keyword analog in
the fifth line define the analog block. The line 7 declare the relationship between voltage

43



44 Chapter 5. Results and Discussion

and current. V(p,n) represents the potential difference measured between ports p and n.
I(p,n) represents the current flowing from port p to n. The value of current is multiplied by
the value of the parameter resistance. The “<+ ” is named as the contribution operator,
which indicates an equation that must be satisfied by the simulator. It indicates that the
potential difference on branch between port p and n must equal to the current through
this branch multiplied by resistance.

5.1.2 The simulation result of reisstor model in NI AWRDE

Figure 5.1: Circuit of Our Resistance

In Figure 5.1 shows the circuit of our resistance. Stepped (start, stop, step) uses to
generate a vector of real values from start to stop

In our case, the AC voltage start at 0.1V and keep increase by 1V until reach 10V.
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Figure 5.2: I-V characteristic Curves of our resistor in both Harmonic Balance simulator
and APLAC DC simulator

Figure 5.2 shows the values of current through the resistance by AC voltage across it. The
simulation result shows a good agreement between theory and simulation. Linear current
obeys Ohms Law as the voltage across the resistor is linearly proportional to the current
through it.

5.2 Diode Model

5.2.1 A Nonlinear Diode in Verilog-A

Verilog-A is well-suited for describing nonlinear behaviour. The Verilog-A code of PN
junction diode is defined as below:

‘include “disciplines.h”
‘include “constants.h”
module My Diode(anode,cathode);
inout anode,cathode;
electrical anode,cathode;
parameter real is=1e-14 from (0:inf);
parameter real n=1 from (0:inf);
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parameter real tt=1 from (0:inf);
real Vd, Id, Qd;
analog
begin
Vd = V(anode,cathode);
Id = ise

qVd/nkT − 1
Qd = tt ∗ Id;
I(anode,cathode) <+ Id + ddt(Qd);
end
endmodule

The first line defines the name of our model, which is named as My Diode. There are
two ports, which called “anode” and “cathode”. “anode” is input port and “cathode” is
output port. The nature of those ports declared in the electrical discipline. It means pass
through it is current and the potential between these two pins is voltage. Between line
4 and line 6 declares three parameters, which are is, n, and tt. is stands for Saturation
current, and assigns it a default value of 1e-14. N refers to ideality factor, which is between
1 and 2. In our case, we set it as 1. Tt stands for transit time, assign it with a value
of 1. Those parameters are declared in real type. Vd=V(anode,cathode) is declares Vd
is equal to the voltage across the diode connected between nodes anode and cathode of
the module. Id is net current flowing through the diode. We know Id = ise

qVd/nkT − 1
for actual diode. Where k is Bolzmanns constant , q is absolute value of electron charge,
T is absolute temperature, which is also called as room temperature and equal to 300K.
VT = kTq = 0.026V is thermal voltage. Qd stand for charge and equal to transit time
multiplied by current through the diode.

I(anode,cathode) <+ Id + ddt(Qd);

It is same behaviour to following two statements.

I(anode,cathode) <+ Id
I(anode,cathode) <+ ddt(Qd);

The “<+” is called the contribution operator and in our case contributes the value of Id
or ddt(Qd) as the voltage from anode to cathode.

In Figure 5.3 shows the circuit of our diode. Stepped (start, stop, step) uses to generate
a vector of real values from start to stop

In our case, the AC voltage start at 0.5V and keep increase by 0.01V until reach 1.2V.
The symbol Is is Saturation current. The symbol n is emission efficient, between 1 and
2. The symbol tt is transit time, which is equal to 1s for our situation.
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Figure 5.3: Circuit of Our Diode

In Figure 5.4, the diode is forward biased, anode positive with respect to the cathode,
a positive or forward current passes through the diode. Starting at zero, the forward
current and voltage are very small. Until the forward voltage exceeds the diodes P-N
junctions internal barrier voltage, which is about 0.7 volts, the forward current start to
increases rapidly for an extremely small increase in voltage create a non-linear curve. The
simulation results shows a good agreement between theoretical characteristic of diode and
simulation.

5.3 Transistor Model

5.3.1 A Nonlinear Transistor in Verilog-A

The electrical behaviour of the devices transistors required to be described accurately in
Verilog-A.

In Figure 5.5 shows the circuit of our transistor., we use IVCURVEI to apply the voltage
in collector and the current in base to construct our transistor circuit.

All previously components (resistor, diode) only have two terminals, therefore be char-
acterized by the simple relationship between the current flow through and the voltage
across the two terminals. Differently, a transistor has three-terminals, which are emitter,
base and collector.
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Figure 5.4: I-V Characteristic Curve of Our diode in both Harmonic Balance simulator
and APLAC DC simulator

module My bjt(c,b,e);
inout c,b,e;
electrical ci,b,ei, bi, c,e;

In Verilog-A code, three terminals of transistor present in My bjt(c,b,e). NI AWRDE the
three terminals of transistor appear in number. 1 corresponding to base, 2 corresponding
to collector, 3 corresponding to emitter. The error of simulation may due to three thermals
of transistor not corresponding to correct number in NI AWRDE, which how NI AWRDE
presented terminals of transistor.

Compare to resistor model and diode model. Transistor model requires to use much more
parameters. All parameters must determine in accuracy way. Obviously the code will be
much complicated to previous. And also required to add the internal noises in transistor
model. ci refers to internal collector current, ei stands for internal emitter current. bi
stands for internal base current. It allows to access the internal current of transistor.

5.4 Chapter Summary

In this chapter, we import verilog-A code into NI AWRDE. Edit model definition. Gener-
ate source code and Aplac source code in order to create model. The simulation result for
resistor and diode, which obtained from NI AWRDE is quite good. It has good agreement
with theoretical solutions. There are some issues with transister model. It may because
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Figure 5.5: Circuit of Our Transistor

three thermal declared in Verilog-A is different to three thermal declared in NI AWRDE.
The way to solve it, we can try voltage controlled current source and set schematic sym-
bol of voltage controlled current source to default. It will help use to determine how NI
AWRDE present thermials of volatage controlled current source. Unfortunately we do
not have enough to try it. Once we figure out that, we can try our transistor model again.
It may work.

Finally, we have learned how to use NI AWRDE and visual studio to create model in
PDK.
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Chapter 6

Conclusions and Future Work

6.1 Future Work

The previous chapters presents activities perfromed involve with this project. This chap-
ter will briefly discuss some possible enhancements that can be made base on the current
model. The thesis focused on how implementing model wizard in NI AWRDE and us-
ing Microsoft visual studio to create model. The follwing section will presented some
suggestions can be explored in the future projects.

6.1.1 Add Noise to the Verilog-A Resistor

Verilog-A provides a couple of ways to add noise, contain frequency-dependent, frequency-
independent and piecewise linear frequency -dependent noise. The thermal noise is defined
as 4 ∗K ∗ T/R . T is termperature of the circuit, which will be changed due to outside
of the model. White noise() operator is used for contribute noise.

analog V(p,n) <+ R * I(p,n);
change to
V(p,n) <+ R * I(p,n) + white noise(4 * ‘P K * temperature/R,”thermal”);

By change this part of our previous code. It will help use to achieve resistor with noise.
We can investiage I-V characteristic of resistor. To explore how noise effect in I-V char-
acteristic of resistor.

6.1.2 Add an Internal Node to the diode

The prominent diode require to contain the drop in the junction voltage because of the
series resistance. The way to implementing the series resistance will require to ad an
internal nide. An internal node is also called as a net, which can be add by declaring the
node as electrical.
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electrical anode, cathode, internal;

It allow designer to explore the internal port of diode.

6.1.3 Add limiting to the diode for get better convergence

In our diode code use the exponential function, which result in large swings in currents
for small modifications in voltage. exp() can be replaced by a special operator(limexp()),
which enable the simulator algorithms to restrict the exponential in simulator-specific
ways.

6.1.4 The Verilog-A of transistor

// voltage controlled current source module vcvs (pout, nout, pin, nin);

electrical pout, nout, pin, nin;
parameter real gain=1;

analog V(pout,nout) <+ gain*I(pin,nin);
endmodule

The terminal port of transistor present in verilog-A by name, however the terminal port of
transistor present in NI AWRDE in number. First, we can try Voltage controlled current
source and set the schematic symbol of Voltage controlled current source to be default, to
explore how port name present in verilog-A corresponding to port number in NI AWRDE.
Once we know that, it will help us to figure out how port name present in verilog-A of
transistor corrsponding to the port number of transistor in NI AWRDE. It may result
our simulation work fine. To investigate how the internal noise of transistor effect the
characterstic of transistor, which include self-heating effect.
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Abbreviations

Analog HDLs Analog Hardware Description languages
RFICs Radio Frequency Integrated Circuits
HBT Heterojunction Bipolar Transistor
GP model Gummel-Poon model
FETs The field-effect transistors
VBIC model Vertical Bipolar Inter-Company
PDK Process Design Kit
SDK Software development Kit
FBH Ferdinand-Braun-Institut fr Hchstfrequenztechnik
GaAs Gallium arsenide
AlGaAs Aluminium gallium arsenide
GaInP Gallium indium phosphide
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Appendix A

Verilog-A Code

A.1 Overview

All the Verilog-A codes written during the project will be provided here for the reference
of readers.

A.2 Resistor in Verilog-A

A.3 Diode in Verilog-A

A.4 Transistor in Verilog-A
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Appendix B

Project Plan and Attendance Form

B.1 Overview

This section includes the project plan (Gnatt Chart) represent project specification. And
also include the consultation meetings attendance form as need by the department.
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B.2 Consultation Meetings Attendance Form

Make attendance chart 



B.3 Project Plan 67

B.3 Project Plan

While allocating a thesis project to a student, the student is expected to have analytical
problem solving skills, willing to learn CAD software and Verilog-A computer program
and knowledge obtained during learning course of last 3 years in electronic engineering
degree. Some of the generic skills would contain using Gantt chart excel, Microsoft words
and AWR. In order to get simulation results and write in formal report with correct
format and referencing. Projects are allocated to the students on the fundamental of
their corresponding engineering knowledge in electronic. The student undertaking this
project are required to have those techniques as below:

• Good mathematical analysis knowledge

• Good understanding about the characteristic of transistor models

• Use of simulation software such as AWR and visual studio.

• Good understanding in Verilog-A computer program.

The whole thesis project involves the concept of search, design and implementation and
testing. The thesis projects begin the first week of semester 1 2016. The first week will be
start off with the fundamental literature review about the concept of Verilog-A modelling
of transistor. And also install the software to use for implement Verilog-A modelling
of transistor which are AWR and visual studio 2013. The next couple weeks is to get
familiar with how implement model wizard in AWR and using Microsoft visual studio to
test model. The feedback received from the progress report will be used to improve the
final report. It will include all the simulation results from AWR. The followed by seminar
presentation where students will need to demonstrate their own project to audience of
academic and final year students. It will require to present what we did during our thesis
and what achievement from that project.

B.4 Project Consultation meetings

The students are required to meet with their academic supervisors every week and to
provide a brief outline about the progress reports every two weeks.

B.5 LOGBOOK

The students are required to have a bound logbook recording the work undertaken in the
project.
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